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1 Using Your EDUNet Computer 

The purpose of this document is to describe the day-to-day use of EDUNet desktop computers. In 
addition to introductory guides to key software packages provided for your use, this document includes 
guidelines to ensure that your use of EDUNet computers and networks is in keeping with EDUNet ICT 
policy and that you are aware of your rights and responsibilities as outlined in those policies. 

1.1 Starting and Stopping Your Desktop Computer 

When you first arrive in the morning always follow the same procedure from start up: 

1. Turn on the wall outlet feeding the Uninterruptible Power Supply (U.P.S.). 
2. Turn on the U.P.S and check that its indicator lights are favorable (differs from model to model). 
3. Turn on the desktop computer and monitor 
4. Check that you have access to the Internet and GES Intranet. If not, you may need to remind 

someone to power up the network router and printer. 

When you leave at the end of the day always follow the same procedure for shutdown: 

1. From the Windows Start Menu select Shutdown and wait for it to complete. 
2. Turn off the U.P.S. 
3. Turn off the wall outlet feeding the U.P.S.  

It is especially important to follow the shutdown sequence because leaving the U.P.S. on without power 
will cause the U.P.S. to fully drain. With repeated cycles, the battery in the U.P.S. will be ruined. 

1.2 Your User Account 

A user account has been created for your use. Whenever you use the desktop computer you must login 
using this account. The first time you login you must set your password according to the guidelines 
below. An email account has also been created for you to use when conducting official business. Do not 
use this email account for personal use and also do not use your personal account for official business. 
Do not share your user account with anyone else. 

With the privilege of having these accounts comes responsibility for their proper use. You are required to 
familiarize yourself with the Acceptable Use Policy which accompanies this document.  

You will be asked to sign a form indicating that you understand and accept the terms of the Acceptable 
Use Policy and the provisions of this EDUNet Computer Manual. 

1.3 Password Management Practices 

You are responsible for the use of the desktop computer when you are logged in and for choosing and 
protecting your password so that your account remains secure. This section documents mandatory 
practices for the selection and management of passwords for all of your user accounts. 

All computer users must: 

 Select strong passwords in compliance with the Password Strength section of this document 
below, 

 Never share their user account with another user and never disclose their password to anyone, 
including someone claiming to be from customer service, help desk or any other department, 

 Never write down their password, or communicate their password via email, instant messaging, 
or telephone, 
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 Change their password at recommended intervals or when there is concern that the password 
may have been compromised, 

 Use different passwords for official operating system login (e.g., Windows 7), desktop 
applications and Web applications; under no circumstances should the same password be used 
for official and personal use. 

Password Strength 

 Passwords must be at least 8 characters in length, must contain at least one uppercase character, 
at least one lowercase character, at least one numeric character and at least one special 
character from the following set: $, [, ], (, ), {, }, or !. 

 Passwords must be changed every 6 months and may not be reused. 

1.4 Document Management 

During the course of your work you will accrue many documents: correspondence, administrative forms, 
presentations for talks, photographs and videos, etc. Some documents you will create, others you may 
download from the Web or receive via email correspondence. These documents are invaluable not only 
to yourself and those who may fill your role after you retire or move to a new job, but they are a critical 
information asset of the Ghana Education Service.  

It is your responsibility to ensure that these files are saved to your computer in folders that are backed 
up to external storage managed by the EDUNet ICT Group. 

Most Microsoft software packages will offer to save documents in a common default location. Word, for 
example, offers to save your document in a folder in your home called My Documents. Photo and image 
applications typically offer to save to My Pictures and so on. 

EDUNet ICT policy stipulates that each EDUNet desktop computer be backed up weekly to external 
storage media and stored offsite. Currently, the policy dictates that a user's entire home directory (i.e., 
for user Abena, the contents of C:\Users\Abena) which includes the default folders My Documents, My 
Pictures, and the contents of the user's Windows Desktop folder. 

1.5 Monitoring of Computer Use 

You are reminded that EDUNet computers are provided to carry out official business of GES and that you 
may not save personal documents and that documents that you do save are the property of GES.  

Be aware that ICT Administrators are tasked with verifying that EDUNet users are adhering to ICT 
policy which may include random checks of the files stored on a users computer, email being received 
and sent by users, Web sites being visited, and other checks. 

1.6 Securing Your Desktop 

The first line of defence against security breaches on the desktop is you, the user. It is your responsibility 
to be aware of and comply with the following desktop security recommendations: 

 Users are advised to enable a pop-up blocker in the Web browser. Pop-up windows are small 
browser windows that appear on top of the website you're viewing. Although most are created 
by advertisers, they can also contain malicious or unsafe code. A pop-up blocker can prevent 
some or all of these windows from appearing. The Pop-up Blocker feature in Internet Explorer is 
turned on by default. Users of Firefox or Chrome are advised to ensure their browsers also block 
pop-ups. 

 Users are advised not to open email messages from unfamiliar senders, or email attachments 
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that you don't recognize. Many viruses are attached to email messages and will spread as soon 
as you open the email attachment. It's best not to open any attachment unless it is something 
you are expecting. 

 Users are advised to always logout or lock the screen when leaving the computer unattended. 

 Users must not disable default security settings made by ICT admin staff. 

1.7 Day-to-day Maintenance 

Some of us work in very dusty environments. Dust can play havoc with computer equipment. Protect 
keyboard and mouse with a plastic cover when not in use (you can also purchase keyboards covers that 
can remain in place during use). The system unit has a built-in fan that will have reduced efficiency if 
allowed to build up with dust. It is recommended to have quarterly or semi-annual cleaning of the 
mother board, CPU fan and system fan to preserve the life of the desktop system. If you believe that your 
system is not being cleaned on a schedule please contact your ICT representative to request that your 
system be added to a regular maintenance schedule. 

1.8 Key GES Applications 

The remainder of this document contains introductions to the following key applications that are 
available on your desktop: 

 2   Introduction to Computers 

 3   Introduction to Microsoft Word 

 4   Introduction to the Web 

 5   Introduction to Zimbra Email 
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2 Introduction to Computers 

Are you new to computers? Do you wonder what they do and why you would want to use one? 
Welcome—you're in the right place. Read on for an overview of computers: what they are, the different 
types, and what you can do with them. 

2.1 What are computers? 

Computers are machines that perform tasks or calculations according to a set of instructions, or 
programs. The first fully electronic computers, introduced in the 1940s, were huge machines that 
required teams of people to operate. Compared to those early machines, today's computers are 
amazing. Not only are they thousands of times faster, they can fit on your desk, in your lap, or even in 
your pocket. 

Computers work through an interaction of hardware and software. Hardware refers to the parts of a 
computer that you can see and touch, including the case and everything inside it. The most important 
piece of hardware is a tiny rectangular chip inside your computer called the central processing unit 
(CPU), or microprocessor. It's the "brain" of your computer—the part that translates instructions and 
performs calculations. Hardware items such as your monitor, keyboard, mouse, printer, and other items 
are often called hardware devices, or devices. 

Software refers to the instructions, or programs, that tell the hardware what to do. A word processing 
program that you can use to write letters on your computer is a type of software. The operating system 
(OS) is software that manages your computer and the devices connected to it. Two well-known operating 
systems are Windows and Macintosh operating system. Your computer uses the Windows operating 
system. 

2.2 Types of computers 

Computers range in size and capability. At one end of the scale are supercomputers, very large 
computers with thousands of linked microprocessors that perform extremely complex calculations. At 
the other end are tiny computers embedded in cars, TVs, stereo systems, calculators, and appliances. 
These computers are built to perform a limited number of tasks. 

The personal computer, or PC, is designed to be used by one person at a time. This section describes the 
various kinds of personal computers: desktops, laptops, handheld computers, and Tablet PCs. 

ENIAC 

Introduced in 1946, ENIAC (Electronic Numerical Integrator And Computer) was the first general-purpose 
electronic computer. It was built for the United States military to calculate the paths of artillery shells. 
Physically, ENIAC was enormous, weighing more than 27,000 kilograms (60,000 pounds) and filling a 
large room. To process data, ENIAC used about 18,000 vacuum tubes, each the size of a small light bulb. 
The tubes burned out easily and had to be constantly replaced. 

Desktop computers 

Desktop computers are designed for use at a desk or table. They are typically larger and more powerful 
than other types of personal computers. Desktop computers are made up of separate components. The 
main component, called the system unit, is usually a rectangular case that sits on or underneath a desk. 
Other components, such as the monitor, mouse, and keyboard, connect to the system unit. 
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Desktop computer 

Laptop computers 

Laptop computers are lightweight mobile PCs with a thin screen. They are often called notebook 
computers because of their small size. Laptops can operate on batteries, so you can take them 
anywhere. Unlike desktops, laptops combine the CPU, screen, and keyboard in a single case. The screen 
folds down onto the keyboard when not in use. 

 

Laptop computer 

Handheld computers 

Handheld computers, also called Personal Digital Assistants (PDAs), are battery-powered computers 
small enough to carry almost anywhere. Although not as powerful as desktops or laptops, handhelds are 
useful for scheduling appointments, storing addresses and phone numbers, and playing games. Some 
have more advanced capabilities, such as making telephone calls or accessing the Internet. Instead of 
keyboards, handhelds have touch screens that you use with your finger or a stylus (a pen-shaped 
pointing tool). 
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Handheld computer 

Tablet PCs 

Tablet PCs are mobile PCs that combine features of laptops and handhelds. Like laptops, they're 
powerful and have a built-in screen. Like handhelds, they allow you to write notes or draw pictures on 
the screen, usually with a tablet pen instead of a stylus. They can also convert your handwriting into 
typed text. Some Tablet PCs are “convertibles” with a screen that swivels and unfolds to reveal a 
keyboard underneath. 

 

Tablet PC 

2.3 What can you do with computers? 

In the workplace, many people use computers to keep records, analyze data, do research, and manage 
projects. At home, you can use computers to find information, store pictures and music, track finances, 
play games, and communicate with others—and those are just a few of the possibilities. 

You can also use your computer to connect to the Internet, a network that links computers around the 
world. Internet access is available for a monthly fee in most urban areas, and increasingly, in less 
populated areas. With Internet access, you can communicate with people all over the world and find a 
vast amount of information. 

Here are some of the most popular things to do with computers: 

The web 

The World Wide Web (usually called the Web, or web) is a gigantic storehouse of information. The web is 
the most popular part of the Internet, partly because it displays most information in a visually appealing 
format. Headlines, text, and pictures can be combined on a single webpage—much like a page in a 
magazine—along with sounds and animation. A website is a collection of interconnected webpages. The 
web contains millions of websites and billions of webpages. 
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Example of a webpage (Microsoft Game Studios) 

Surfing the web means exploring it. You can find information on the web about almost any topic 
imaginable. For example, you can read news stories and movie reviews, check airline schedules, see 
street maps, get the weather forecast for your city, or research a health condition. Most companies, 
government agencies, museums, and libraries have websites with information about their products, 
services, or collections. Reference sources, such as dictionaries and encyclopedias, are also widely 
available. 

The web is also a shopper's delight. You can browse and purchase products—books, music, toys, 
clothing, electronics, and much more—at the websites of major retailers. You can also buy and sell used 
items through websites that use auction-style bidding. 

Email 

Email (short for electronic mail) is a convenient way to communicate with others. When you send an 
e-mail message, it arrives almost instantly in the recipient's e-mail inbox. You can send e-mail to many 
people simultaneously, and you can save, print, and forward e-mail to others. You can send almost any 
type of file in an e-mail message, including documents, pictures, and music files. And with e-mail, you 
don't need a stamp! 

Instant messaging 

Instant messaging is like having a real-time conversation with another person or a group of people. 
When you type and send an instant message, the message is immediately visible to all participants. 
Unlike e-mail, all participants have to be online (connected to the Internet) and in front of their 
computers at the same time. Communicating by means of instant messaging is called chatting. 

Pictures, music, and movies 

If you have a digital camera, you can move your pictures from the camera to your computer. Then you 
can print them, create slide shows, or share them with others by e-mail or by posting them on a website.  

You can also listen to music on your computer, either by importing (transferring to your computer) music 
from audio CDs or by purchasing songs from a music website. Or, tune in to one of the thousands of 
radio stations that broadcast over the Internet. If your computer comes with a DVD player, you can watch 
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movies. 

Gaming 

Do you like to play games? Thousands of computer games in every conceivable category are available to 
entertain you. Get behind the wheel of a race car, battle frightening creatures in a dungeon, or control 
civilizations and empires! Many games allow you to compete with other players around the world 
through the Internet. Windows includes a variety of card games, puzzle games, and strategy games 

2.4 Parts of a computer 

If you use a desktop computer, you might already know that there isn't any single part called the 
"computer." A computer is really a system of many parts working together. The physical parts, which you 
can see and touch, are collectively called hardware. (Software, on the other hand, refers to the 
instructions, or programs, that tell the hardware what to do.) 

The illustration below shows the most common hardware in a desktop computer system. Your system 
may look a little different, but it probably has most of these parts. A laptop computer has similar parts 
but combines them into a single notebook-sized package. 

 

Desktop computer system 

Let's take a look at each of these parts. 

System unit 

The system unit is the core of a computer system. Usually it's a rectangular box placed on or underneath 
your desk. Inside this box are many electronic components that process information. The most important 
of these components is the central processing unit (CPU), or microprocessor, which acts as the "brain" of 
your computer. Another component is random access memory (RAM), which temporarily stores 
information that the CPU uses while the computer is on. The information stored in RAM is erased when 
the computer is turned off. 

Almost every other part of your computer connects to the system unit using cables. The cables plug into 
specific ports (openings), typically on the back of the system unit. Hardware that is not part of the 
system unit is sometimes called a peripheral device or device. 
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System unit 

Storage 

Your computer has one or more disk drives—devices that store information on a metal or plastic disk. 
The disk preserves the information even when your computer is turned off. 

Hard disk drive 

Your computer's hard disk drive stores information on a hard disk, a rigid platter or stack of platters with 
a magnetic surface. Because hard disks can hold massive amounts of information, they usually serve as 
your computer's primary means of storage, holding almost all of your programs and files. The hard disk 
drive is normally located inside the system unit. 

 

Hard disk drive 

CD and DVD drives 

Nearly all computers today come equipped with a CD or DVD drive, usually located on the front of the 
system unit. CD drives use lasers to read (retrieve) data from a CD, and many CD drives can also write 
(record) data onto CDs. If you have a recordable disk drive, you can store copies of your files on blank 
CDs. You can also use a CD drive to play music CDs on your computer. 
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CD 

DVD drives can do everything that CD drives can, plus read DVDs. If you have a DVD drive, you can watch 
movies on your computer. Many DVD drives can record data onto blank DVDs. 

Tip 

If you have a recordable CD or DVD drive, periodically back up (copy) your important files to CDs or DVDs. 
That way, if your hard disk ever fails, you won't lose your data. 

Mouse 

A mouse is a small device used to point to and select items on your computer screen. Although mice 
come in many shapes, the typical mouse does look a bit like an actual mouse. It's small, oblong, and 
connected to the system unit by a long wire that resembles a tail. Some newer mice are wireless. 

 

Mouse 

A mouse usually has two buttons: a primary button (usually the left button) and a secondary button. 
Many mice also have a wheel between the two buttons, which allows you to scroll smoothly through 
screens of information. 

 

When you move the mouse with your hand, a pointer on your screen moves in the same direction. (The 
pointer's appearance might change depending on where it's positioned on your screen.) When you want 
to select an item, you point to the item and then click (press and release) the primary button. Pointing 
and clicking with your mouse is the main way to interact with your computer. 

Keyboard 

A keyboard is used mainly for typing text into your computer. Like the keyboard on a typewriter, it has 
keys for letters and numbers, but it also has special keys: 

 The function keys, found on the top row, perform different functions depending on where they 
are used. 
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 The numeric keypad, located on the right side of most keyboards, allows you to enter numbers 
quickly. 

 The navigation keys, such as the arrow keys, allow you to move your position within a document 
or webpage. 

 

Keyboard 

You can also use your keyboard to perform many of the same tasks you can perform with a mouse. 

Monitor 

A monitor displays information in visual form, using text and graphics. The portion of the monitor that 
displays the information is called the screen. Like a television screen, a computer screen can show still or 
moving pictures. 

There are two basic types of monitors: CRT (cathode ray tube) monitors and LCD (liquid crystal display) 
monitors. Both types produce sharp images, but LCD monitors have the advantage of being much thinner 
and lighter. CRT monitors, however, are generally more affordable. 

 

LCD monitor (left); CRT monitor (right) 

Printer 

A printer transfers data from a computer onto paper. You don't need a printer to use your computer, but 
having one allows you to print e-mail, cards, invitations, announcements, and other materials. Many 
people also like being able to print their own photos at home. 

The two main types of printers are inkjet printers and laser printers. Inkjet printers are the most popular 
printers for the home. They can print in black and white or in full color and can produce high-quality 
photographs when used with special paper. Laser printers are faster and generally better able to handle 
heavy use. 
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Inkjet printer (left); laser printer (right) 

Speakers 

Speakers are used to play sound. They may be built into the system unit or connected with cables. 
Speakers allow you to listen to music and hear sound effects from your computer. 

 

Computer speakers 

Modem 

To connect your computer to the Internet, you need a modem. A modem is a device that sends and 
receives computer information over a telephone line or high-speed cable. Modems are sometimes built 
into the system unit, but higher-speed modems are usually separate components. 

 

Cable modem 

2.5 Using the Mouse 

Just as you would use your hands to interact with objects in the physical world, you can use your mouse 
to interact with items on your computer screen. You can move objects, open them, change them, throw 
them away, and perform other actions, all by pointing and clicking with your mouse. 



EDUNet Computer Manual 

 
 

March 2012 13 | P a g e  

Basic parts 

A mouse typically has two buttons: a primary button (usually the left button) and a secondary button 
(usually the right button). The primary button is the one you will use most often. Most mice also include 
a scroll wheel between the buttons to help you scroll through documents and webpages more easily. On 
some mice, the scroll wheel can be pressed to act as a third button. Advanced mice might have 
additional buttons that can perform other functions. 

 

Parts of a mouse 

Holding and moving the mouse  

 
Place your mouse beside your keyboard on a clean, smooth surface, such as a mouse pad. Hold the 
mouse gently with your index finger resting on the primary button and your thumb resting on the side. 
To move the mouse, slide it slowly in any direction. Don't twist it—keep the front of the mouse aimed 
away from you. As you move the mouse, a pointer (see picture) on your screen moves in the same 
direction. If you run out of room to move your mouse on your desk or mouse pad, just pick up the 
mouse and bring it back closer to you. 

 

Hold the mouse lightly, keeping your wrist straight 

Pointing, clicking, and dragging 

Pointing to an item on the screen means moving your mouse so the pointer appears to be touching the 
item. When you point to something, a small box often appears that describes the item. For example, 
when you point to the Recycle Bin on the desktop, a box appears with this information: "Contains the 
files and folders that you have deleted." 
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Pointing to an object often reveals a descriptive message about it. The pointer can change depending on 
what you're pointing to. For example, when you point to a link in your web browser, the pointer changes 

from an arrow to a hand with a pointing finger . 

Most mouse actions combine pointing with pressing one of the mouse buttons. There are four basic 
ways to use your mouse buttons: clicking, double-clicking, right-clicking, and dragging. 

Clicking (single-clicking) 

To click an item, point to the item on the screen, and then press and release the primary button (usually 
the left button). 

Clicking is most often used to select (mark) an item or open a menu. This is sometimes called single-
clicking or left-clicking. 

Double-clicking 

To double-click an item, point to the item on the screen, and then click twice quickly. If the two clicks are 
spaced too far apart, they might be interpreted as two individual clicks rather than as one double-click. 

Double-clicking is most often used to open items on your desktop. For example, you can start a program 
or open a folder by double-clicking its icon on the desktop. 

Tip 

If you have trouble double-clicking, you can adjust the double-click speed (the amount of time acceptable 
between clicks). Follow these steps: 

1. Open Mouse by clicking the Start button , clicking Control Panel, clicking Hardware, and 
then clicking Mouse.  

2. Click the Buttons tab, and then, under Double-click speed, move the slider to increase or 
decrease the speed. 

Right-clicking 

To right-click an item, point to the item on the screen, and then press and release the secondary button 
(usually the right button). 

Right-clicking an item usually displays a list of things you can do with the item. For example, when you 
right-click the Recycle Bin on your desktop, Windows displays a menu allowing you to open it, empty it, 
delete it, or see its properties. If you're ever unsure of what to do with something, right-click it. 



EDUNet Computer Manual 

 
 

March 2012 15 | P a g e  

 

Right-clicking the Recycle Bin opens a menu of related commands 

Dragging 

You can move items around your screen by dragging them. To drag an object, point to the object on the 
screen, press and hold the primary button, move the object to a new location, and then release the 
primary button. 

Dragging (sometimes called dragging and dropping) is most often used to move files and folders to a 
different location and to move windows and icons around on your screen. 

Using the scroll wheel 

If your mouse has a scroll wheel, you can use it to scroll through documents and webpages. To scroll 
down, roll the wheel backward (toward you). To scroll up, roll the wheel forward (away from you). 

Customizing your mouse 

You can change your mouse settings to suit your personal preferences. For example, you can change how 
fast your mouse pointer moves around the screen, or change the pointer's appearance. If you're left-
handed, you can switch the primary button to be the right button.  

Tips for using your mouse safely 

Holding and moving your mouse properly can help you avoid soreness or injury to your wrists, hands, 
and arms, particularly if you use your computer for long periods of time. Here are some tips to help you 
avoid problems: 

 Place your mouse at elbow level. Your upper arms should fall relaxed at your sides. 

 Don't squeeze or grip your mouse tightly. Hold it lightly. 

 Move the mouse by pivoting your arm at your elbow. Avoid bending your wrist up, down, or to 
the sides. 

 Use a light touch when clicking a mouse button. 

 Keep your fingers relaxed. Don't allow them to hover just above the buttons. 

 When you don't need to use the mouse, don't hold it. 

 Take short breaks from computer use every 15 to 20 minutes. 
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2.6 Using your keyboard 

Whether you're writing a letter or entering numerical data, your keyboard is the main way to enter 
information into your computer. But did you know you can also use your keyboard to control your 
computer? Learning just a few simple keyboard commands (instructions to your computer) can help you 
work more efficiently. This article covers the basics of keyboard operation and gets you started with 
keyboard commands. 

How the keys are organized 

The keys on your keyboard can be divided into several groups based on function: 

 Typing (alphanumeric) keys. These keys include the same letter, number, punctuation, and 
symbol keys found on a traditional typewriter. 

 Control keys. These keys are used alone or in combination with other keys to perform certain 

actions. The most frequently used control keys are CTRL, ALT, the Windows logo key , and ESC. 

 Function keys. The function keys are used to perform specific tasks. They are labeled as F1, F2, 
F3, and so on, up to F12. The functionality of these keys differs from program to program. 

 Navigation keys. These keys are used for moving around in documents or webpages and editing 
text. They include the arrow keys, HOME, END, PAGE UP, PAGE DOWN, DELETE, and INSERT. 

 Numeric keypad. The numeric keypad is handy for entering numbers quickly. The keys are 
grouped together in a block like a conventional calculator or adding machine. 

The following illustration shows how these keys are arranged on a typical keyboard. Your keyboard layout 
may differ. 

 

How the keys are arranged on a keyboard 

Typing text 

Whenever you need to type something in a program, e-mail message, or text box, you'll see a blinking 

vertical line (  ). That's the cursor, also called the insertion point. It shows where the text that you type 
will begin. You can move the cursor by clicking in the desired location with the mouse, or by using the 
navigation keys (see the "Using navigation keys" section of this article). 

In addition to letters, numerals, punctuation marks, and symbols, the typing keys also include SHIFT, 
CAPS LOCK, the TAB key, ENTER, the SPACEBAR, and BACKSPACE. 
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Key name  How to use it  

SHIFT 
Press SHIFT in combination with a letter to type an uppercase letter. Press SHIFT in 
combination with another key to type the symbol shown on the upper part of that key. 

CAPS LOCK 
Press CAPS LOCK once to type all letters as uppercase. Press CAPS LOCK again to turn this 
function off. Your keyboard may have a light indicating whether CAPS LOCK is on. 

TAB 
Press the TAB key to move the cursor several spaces forward. You can also press the TAB 
key to move to the next text box on a form. 

ENTER 
Press ENTER to move the cursor to the beginning of the next line. In a dialog box, press 
ENTER to select the highlighted button. 

SPACEBAR Press the SPACEBAR to move the cursor one space forward. 

BACKSPACE Press BACKSPACE to delete the character before the cursor, or the selected text. 

Using keyboard shortcuts 

Keyboard shortcuts are ways to perform actions by using your keyboard. They're called shortcuts 
because they help you work faster. In fact, almost any action or command you can perform with a mouse 
can be performed faster using one or more keys on your keyboard. 

In Help topics, a plus sign (+) between two or more keys indicates that those keys should be pressed in 
combination. For example, CTRL+A means to press and hold CTRL and then press A. CTRL+SHIFT+A 
means to press and hold CTRL and SHIFT and then press A. 

Find program shortcuts 

You can do things in most programs by using the keyboard. To see which commands have keyboard 
shortcuts, open a menu. The shortcuts (if available) are shown next to the menu items. 

 

Keyboard shortcuts appear next to menu items 

Choose menus, commands, and options 

You can open menus and choose commands and other options using your keyboard. When you press ALT 
in a program with menus, one letter in each of the menu names becomes underlined. Press an 
underlined letter to open the corresponding menu. Press the underlined letter in a menu item to choose 
that command. 
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Press ALT+F to open the File menu, then press P to choose the Print command 

This trick works in dialog boxes too. Whenever you see an underlined letter attached to an option in a 
dialog box, it means you can press ALT plus that letter to choose that option. 

Useful shortcuts 

The following table lists some of the most useful keyboard shortcuts.  

Press this  To do this  

Windows logo key  Open the Start menu 

ALT+TAB Switch between open programs or windows 

ALT+F4 Close the active item, or exit the active program 

CTRL+S Save the current file or document (works in most programs) 

CTRL+C Copy the selected item 

CTRL+X Cut the selected item 

CTRL+V Paste the selected item 

CTRL+Z Undo an action 

CTRL+A Select all items in a document or window 

F1 Display Help for a program or Windows 

Windows logo key 

+F1 
Display Windows Help and Support 

ESC Cancel the current task 

Application key  
Open a menu of commands related to a selection in a program. Equivalent to right-
clicking the selection. 

2.7 Using navigation keys 

The navigation keys allow you to move the cursor, move around in documents and webpages, and edit 
text. The following table lists some common functions of these keys. 

Press this  To do this  

LEFT ARROW, RIGHT ARROW, UP 
ARROW, or DOWN ARROW 

Move the cursor or selection one space or line in the direction of the 
arrow, or scroll a webpage in the direction of the arrow 

HOME 
Move the cursor to the beginning of a line or move to the top of a 
webpage 

END Move the cursor to the end of a line or move to the bottom of a 
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webpage 

CTRL+HOME Move to the top of a document 

CTRL+END Move to the bottom of a document 

PAGE UP Move the cursor or page up one screen 

PAGE DOWN Move the cursor or page down one screen 

DELETE 
Delete the character after the cursor, or the selected text; in Windows, 
delete the selected item and move it to the Recycle Bin 

INSERT 
Turn Insert mode off or on. When Insert mode is on, text that you type is 
inserted at the cursor. When Insert mode is off, text that you type 
replaces existing characters. 

2.8 Using the numeric keypad 

The numeric keypad arranges the numerals 0 though 9, the arithmetic operators + (addition), - 
(subtraction), * (multiplication), and / (division), and the decimal point as they would appear on a 
calculator or adding machine. These characters are duplicated elsewhere on the keyboard, of course, but 
the keypad arrangement allows you to rapidly enter numerical data or mathematical operations with 
one hand. 

  

Numeric keypad 

To use the numeric keypad to enter numbers, press NUM LOCK. Most keyboards have a light that 
indicates whether NUM LOCK is on or off. When NUM LOCK is off, the numeric keypad functions as a 
second set of navigation keys (these functions are printed on the keys next to the numerals or symbols). 

You can use your numeric keypad to perform simple calculations with Calculator. 

Operating the Calculator with the Numeric Keypad 

1. Open Calculator by clicking the Start button , clicking All Programs, clicking Accessories, and 
then clicking Calculator.  

2. Check your keyboard light to see if NUM LOCK is on. If it isn't, press NUM LOCK. 

3. Using the numeric keypad, type the first number in the calculation. 

4. On the keypad, type + to add, - to subtract, * to multiply, or / to divide. 

5. Type the next number in the calculation. 



EDUNet Computer Manual 

 
 

March 2012 20 | P a g e  

6. Press ENTER to complete the calculation. 

Three odd keys 

So far, we've discussed almost every key you're likely to use. But for the truly inquisitive, let's explore the 
three most mysterious keys on the keyboard: PRINT SCREEN, SCROLL LOCK, and PAUSE/BREAK. 

PRINT SCREEN (or PRT SCN) 

A long time ago, this key actually did what it says—it sent the current screen of text to your printer. 
Nowadays, pressing PRINT SCREEN captures an image of your entire screen (a "screen shot") and copies 
it to the Clipboard in your computer's memory. From there you can paste it (CTRL+V) into Microsoft Paint 
or another program and, if you want, print it from that program. 

More obscure is SYS RQ, which shares the key with PRINT SCREEN on some keyboards. Historically, SYS 
RQ was designed to be a "system request," but this command is not enabled in Windows. 

Tip 

Press ALT+PRINT SCREEN to capture an image of just the active window, instead of the entire screen. 

SCROLL LOCK (or SCR LK) 

In most programs, pressing SCROLL LOCK has no effect. In a few programs, pressing SCROLL LOCK 
changes the behavior of the arrow keys and the PAGE UP and PAGE DOWN keys; pressing these keys 
causes the document to scroll without changing the position of the cursor or selection. Your keyboard 
might have a light indicating whether SCROLL LOCK is on. 

PAUSE/BREAK 

This key is rarely used. In some older programs, pressing this key pauses the program or, in combination 
with CTRL, stops it from running. 

Other keys 

Some modern keyboards come with "hot keys" or buttons that give you quick, one-press access to 
programs, files, or commands. Other models have volume controls, scroll wheels, zoom wheels, and 
other gadgets. For details about these features, check the information that came with your keyboard or 
computer, or go to the manufacturer's website. 

2.9 Tips for using your keyboard safely 

Using your keyboard properly can help avoid soreness or injury to your wrists, hands, and arms, 
particularly if you use your computer for long periods of time. Here are some tips to help you avoid 
problems: 

 Place your keyboard at elbow level. Your upper arms should be relaxed at your sides. 

 Center your keyboard in front of you. If your keyboard has a numeric keypad, you can use the 
spacebar as the centering point. 

 Type with your hands and wrists floating above the keyboard, so that you can use your whole 
arm to reach for distant keys instead of stretching your fingers. 

 Avoid resting your palms or wrists on any type of surface while typing. If your keyboard has a 



EDUNet Computer Manual 

 
 

March 2012 21 | P a g e  

palm rest, use it only during breaks from typing. 

 While typing, use a light touch and keep your wrists straight. 

 When you're not typing, relax your arms and hands. 

 Take short breaks from computer use every 15 to 20 minutes. 

2.10 Turning off your computer properly 

When you're done using your computer, it's important to turn it off properly—not only to save energy, 
but also to ensure that your data is saved and to help keep your computer more secure. Best of all, your 
computer will start quickly the next time you use it. 

Use the Power button on the Start menu 

To turn off your computer, click the Start button , and then click the Power button in the lower right 
corner of the Start menu. The Power button normally looks like this: 

 

The Power button (sleep) 

When you click this button, your computer goes to sleep. Windows automatically saves your work, the 
display turns off, and any noise from the computer's fan stops. Usually, a light on the outside of your 
computer case blinks or turns yellow to indicate that the computer is sleeping. The whole process takes 
only a few seconds. 

Because Windows saves your work, there's no need to close your programs and files before putting your 
computer to sleep. The next time you turn on your computer (and enter your password, if required), the 
screen will look exactly as it did when you turned off your computer. 

To wake your computer, press the power button on your computer case. Because you don't have to wait 
for Windows to start, your computer wakes within seconds and you can resume work almost 
immediately. 

Note 

While your computer is sleeping, it uses a very small amount of power to maintain your work in its 
memory. If you're using a mobile PC, don't worry— the battery won't be drained. After the computer has 
been sleeping for several hours, or if the battery is running low, your work is saved to the hard disk, and 
then your computer turns off completely, drawing no power. 

Why your Power button might look different 

The Start menu's Power button can change its appearance. Under some circumstances, the button looks 
like this: 

 

The Power button (shut down) 

When you click the button in this form, your computer shuts down. Unlike putting your computer to 
sleep, shutting down closes all open programs, along with Windows itself, and then turns off your 
display and computer completely. Because shutting down doesn't save your work, you must save your 
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files before shutting down. 

The Power button shuts down your computer under the following circumstances: 

 The Sleep option is not available on your computer hardware. 

 You or your computer administrator has set the Power button to always shut down the 
computer. (The settings can be changed by following the instructions below.) 

To change the power button settings 

1. Open Power Options by clicking the Start button , clicking Control Panel, clicking System and 
Maintenance, and then clicking Power Options.  

2. Under the currently selected power plan, click Change plan settings. 
3. In the Edit Plan Settings dialog box, click Change advanced power settings. 
4. In the Power Options dialog box, click the plus sign (+) next to Power buttons and lid to expand 

the list. 
5. Click the plus sign (+) next to Start menu power button to expand the list. 
6. On a desktop computer, in the Setting list, click a setting for the Power button.  

– or – 
On a mobile PC, in the On battery and Plugged in lists, click settings for the Power button. 

7. Click OK. 

If you are connected to a network domain, it's possible that settings made by your network 
administrator (Group Policy settings) will prevent you from completing the steps above. 

There's one other form that the Power button can take. If you've set your computer to receive updates 
automatically, and the updates are ready to be installed, the button appears with a shield on it: 

 

The Power button (installs updates and shut down) 

When you click the button in this form, Windows installs the updates and then shuts down your 
computer when installation is complete. 

Note 

Starting your computer after it has been shut down takes longer than waking your computer from 
sleep—typically 30 seconds or more, depending on the speed of your computer. 

2.11 When to shut down 

Even though putting your computer to sleep is the fastest way to turn it off, and the best option for 
resuming work quickly, there are certain times when you should shut down instead: 

 You are adding or upgrading the hardware inside your computer—such as installing memory, a 
disk drive, a sound card, or a video card. Shut down the computer, and then disconnect it from 
its power source before proceeding with the upgrade. 

 You are adding a printer, monitor, external drive, or other hardware device that does not connect 
to a universal serial bus (USB) or IEEE 1394 port on your computer. Shut down the computer 
before connecting the device. 

To shut down your computer, click the arrow next to the Lock button, and then choose Shut Down. 
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Click the arrow next to the Lock button to access the Shut Down option 

Note 

When adding hardware that uses a USB cable, you don't need to turn off the computer first. Most newer 
devices use USB cables. A USB cable looks like this: 

 

USB cable 

Mobile PC users: Close the lid 

If you have a mobile PC, there's an even easier way to turn off your computer: Close the lid. You can 
choose whether your computer sleeps, shuts down, or enters another power-saving state.  

If you prefer, you can turn off your mobile PC by pressing the power button on its case.  
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3 Introduction to Microsoft Word 

Microsoft Word 2007 is the word processing software in the Microsoft 2007 Office Suite. It allows you to 
easily create a variety of professional-looking documents using features such as themes, styles, and many 
more. 

3.1 Starting Word 

 Click on the Microsoft Button  on the taskbar. 

 Click on All Programs 

 Click on the folder Microsoft Office. 

 Click on Microsoft Office Word 2007. 
 
    When you start Word, a program window opens displaying a blank document. 

3.2 The Word Window 
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Note the following window elements: 

1 The Office Button – This button displays the Office logo in the upper-left corner of Office 2007 
programs, which contains the main menus for the Office program, along with a list of recent 
documents. 

2 Quick Access Toolbar -  This toolbar provides easy access to frequently used commands  

3 Title Bar- It gives the name and the document and the program being used. 

4 Ribbon- It uses commands to tell Microsoft Word what to do. 

5 Minimize- This button makes the window disappear from the screen without closing the 
program.  

6 Maximize/Restore Down- This button makes the window smaller or takes it back to its full size. 

7 Close- This button closes the document or program. 

8 Microsoft Office Word Help – 

9  Ruler- This displays the tabs, indents, margins, and gives the user visual guide for alignment 

10 Scroll bar- Allows the user move up and down in a document window. 

11 Insertion point- A blinking vertical bar that indicates where text, graphics, and other items would 
be inserted. 

12 Text Area- This large white area is where the document is typed. 

13 Status Bar - The Status bar appears at the very bottom of your window and provides such 
information as the current page and the number of words in your document. 

The Microsoft Office Button 

The Office Button  is located in the upper-left corner in the following 2007 Microsoft Office programs 
i.e. Word, Excel, PowerPoint, Access and Outlook. 

When clicked on, it displays a list of basic commands previously available under the File menu of earlier 
versions of Microsoft Office to save, open and print. 
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The Ribbon 

The Ribbon is designed to help you quickly find the commands that you need to complete a task. It also 
replaces menus, task panes and toolbars of various Word versions. Each Ribbon is divided into different 
sections where similar commands are grouped. 

 
 
 
 

 
  
 
 

The Ribbon 

The three parts of a Ribbon are Tabs, Groups, and Commands. 

1 Tabs- There are seven basic ones across the top. Each represents an activity area. 

2 Groups – Each tab has several groups that show related items together. 

3 Commands – A command is a button, a box to enter information, or a menu. Everything on a tab 
has been carefully selected according to user activities. For example the Home tab contains all the 
things most often used, such as the command in the Font group for changing text font: Font, Font 
Size, Bold, Italic etc. 

2 

3 

1 
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Tabs on Ribbon 

Word provides three types of tabs on the Ribbon.  

 The first type is called the standard tab: Home, Insert, Page Layout, References, Mailings, 
Review, and View. 

 The contextual tab which appears only when they are needed based on the type of task. 

 The program tab. This replaces the standard set of tabs when you switch to certain views e.g. 
Print Preview. 

Functions of the Tabs 

Home – Cutting, copying, pasting text or format; changing font, paragraph, and style; editing commands 
such as find, replace and select. 

Insert – Inserting shapes, pages, illustrations, links, headers, footers, texts, symbols, and equations. 

Page Layout - Selecting themes; setting up pages; page backgrounds, paragraphs, and arranging location 
of text and graphic on the page. 

References – Creating table of contents, footnotes, citations, captions, indexes, and tables of authorities. 

Mailings – Creating envelopes and labels, performing mail merges, writing and inserting fields; 
preventing and finishing mail merges. 

Review – Includes spelling and grammar checking, inserting comments, tracking changes, comparing 
documents, and protecting documents. 

View – Changing document views; zooming pages; arranging and working with windows. 

Quick Access Toolbar 

The Quick Access is a customizable toolbar that contains a set of commands that are independent of the 
tab being displayed or commands which are used over and over again- save, undo and repeat. You can 
move the Quick Access Toolbar from one of the two locations and buttons can be added to it that 
represents commands. 

Moving the Quick Access Toolbar 

By default the Quick Access Toolbar is located in the upper-left corner to the Microsoft Office 

Button .  

 

 

Quick Access Toolbar 

To move it to another location: 

1. Click the Customize Quick Access Toolbar list arrow . 
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2. In the list click Show Below the Ribbon or Show Above the Ribbon. 

Adding a Command to the Quick Access Toolbar 

1. Click on the Customize Quick Access Toolbar list arrow . 

2. Click on what command you want to appear on the Quick Access Toolbar. 

Removing a button from the Quick Access Tool bar 

1. Right-Click the button on the Quick Access Toolbar 

2. Then click Remove from Quick Access Toolbar 

The button is removed from the Quick Access Toolbar 

The Status bar 

The Status Bar appears at the bottom of the screen. It displays document information such as word 
count, page numbers, and current display zoom percentage. 

 

Status bar 

Adding or Removing Items from the Status Bar 

To add an item onto the Status bar, Right-click the Status bar, and then click an unchecked item. To 
remove an item from the Status bar, Right-click the Status bar and then click a checked item. 

Rulers 

Horizontal ruler  

This is found above the word document. It shows the length of the typing line, and also used to adjust 
left and right margins and indents, set tabs and change column widths. 

 

Horizontal Ruler    

Vertical Ruler 

This is found along the left edge of the document. The vertical ruler lets you adjust top and bottom 
margins and change table row heights. 
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Vertical Ruler 

3.3 Creating a Document 

Opening a Blank Document 

1. Click on the Office Button  , and then click New. 

2. Double-click Blank Document. 

3. Click Create. 

A new blank document opens in the Word window: 
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Blank Word Document 

Typing a Word Document 

To begin a new document, simply start by typing the text in the blank document in the document 
window. Microsoft Word has a feature known as word wrap that automatically moves the insertion point 
to the next line of the document when you reach the right margin. You only press the Enter key on the 
keyboard when you want to start a new paragraph or insert a blank line. 

When typing text, you might see a red wavy line under a word. This usually indicates a possible 
misspelling. A green wavy line under a text indicates a possible grammar error. 

3.4 Editing Your Document 

Selecting Text 

1. Move the mouse pointer until the I-beam cursor is at the beginning of the text. Click the left 
mouse button and drag the mouse to the right. 

2. Release the mouse button. The selected row is then highlighted. 

Copy, Cut and Paste 

Copy and Paste Using the Ribbon 

1. Highlight the text you want to copy. 

2. Click the Copy button to copy the selection. 

3. Click where you want the copied item to appear. 

4. Click the Paste button to paste. 

Copy and Paste Using the Keyboard 

1. Click before the text. 

2. Hold the Shift key and press the Right arrow key to highlight the text. 

2. Press Ctrl+C to copy the text. 

3. Press Ctrl+V to paste 

Cut and Paste Using the Ribbon 

1. Highlight the text you want to cut. 

2. Click the Cut button to cut the text. 

3. Click where you want the cut text to appear 

4. Click the Paste button to paste. 

Cut and Paste Using the Keyboard 

1. Click before the text. 

2. Hold the Shift key and pres the Right arrow key to highlight the text. 
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3. Press the Ctrl+X to cut the text. 

4. Click where you would like to copy to. 

5. Press Ctrl+V to paste. 

Correcting Typing Errors using the Keyboard 

1. To delete one character to the left of the insertion point press Backspace. 

2. To delete one word to the left of the insertion point press Ctrl+Backspace. 

3. To delete one character to the right of the insertion point, press Delete. 

4. To delete one word to the right of the insertion point press Ctrl+Delete. 

5. To delete a selected text press Backspace or Delete. 

3.5 Saving a Document 

Save a File 

A file is a document permanently stored on the computer that can be opened and edited in the future.  

1. Click the Office Button , and then Click Save. 

2. A Save As dialog box opens if the file is being saved for the first time. 

3. In the File name box, type a new name for the file. 

4. Click Save. 

-- or  using the keyboard -- 

1. Select the text. 

2. Press CTRL+S 

Save as a Different Format 

1. Click the Office Button , click Save As on the File menu. 

2. In the File name box, enter a new name for the file. 

3. In the Save as type box, click on the arrow and a list is generated 

4. Click the file format you want to save the file in. 

5. Click Save. 

3.6 Opening Documents 

Opening an Existing Document 

1. Click on the Office Button  

2. Click Open. 

3. In the File name box, type the name of the file. 
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Opening an Recent document 

1. Click on the Office Button . 

2. On the right is a list of Recent Documents. Click on a recently used document. 

3.7 Document Views 

Word 2007 Document Views 

Under the View tab, there are various document views. 

 Print Layout – This shows the page as it will appear when printed. 

 Full Reading – Shows the page in a way that makes it easy to read on the screen. 

 Web Layout- Shows how the page would look when viewed from a web browser. 

 Outline View – Shows the page in an outline form 

 Draft – Shows the in a simplified format. 

Changing Document Views 

Word displays a document in various ways. The available ways include: Print Layout, Full Screen Reading, 
Web Layout, Outline and Draft. You can change the window from the View tab. To change to any 
document view, click on the available views. 

 

 

Document Views 

You can click a Document view at the of bottom right corner of the Word Window.  

 

3.8 Checking Spelling and Grammar 

You can check spelling and grammar automatically in Word: 

1. Click the Office Button , and the click Word Options. 

2. Click Proofing. 

3. Select the options you want. 

Words that are misspelled or phrases that violate Words rules of grammar are now highlighted. Now you 
can right-click the highlighted problems to see the suggestions. 
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Correcting Text using AutoCorrect 

AutoCorrect corrects common capitalization and spelling errors as you type. To turn on AutoCorrect: 

1. Click the Office Button . 

2. Click Word Options. 

3. Click Proofing. 

4. Click AutoCorrect Options. 

5. Click the AutoCorrect tab. 

3.9 Find and Replace 

Find Text 

You can quickly search for every occurrence of a specific word or phrase. 

1. Click the Home tab. 

2. In the Editing group, click Find. 

3. In the Find what box, type the text that you are searching for. 

4. To highlight all items found, click the Reading Highlight button, and then click Highlight All. 

 

 

Editing 

Find and Replace 

You can automatically replace a word or phrase with another. 

1. Click on the Home tab, in the Editing group, click Replace. 

2. In the Find what box, type the text that you want to search for. 

3. In the Replace with box, type the replacement text. 

4. Do one of the following. 

 To find the next occurrence of the text, click Find Next. 

 To replace an occurrence of the text, click Replace. After you Replace Word 2007 moves to the 
next occurrence of the text. 

 To replace all occurrence of the text, click Replace All. 
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Replace 

 

Editing Panel 

3.10 Document Templates 

A template is a document type that creates a copy of itself when you open it. Templates are exactly like 
documents in that you can provide recommended sections or required text for others to use, as well as 
content controls such as a pre-defined drop-down list or a special logo. You can add protection to a 
section of a template, or you can apply a password to the template to help protect the contents of the 
template from changes. 

Creating a document using a template 

To create a document using a template follow these steps: 

1. Click the Office button , and then New. 

2. Under Templates, click Installed Templates to choose a template. 

3. Click Create. 

Creating a Template from a Starting Document 

1. Click the Office Button , and then click New. 

2. Click Blank document, and then click Create. 

3. Make changes that you want to make to the document. You can also add text that you want to 
appear in all new documents based on the template. 

4. Click the Office Button , and then click Save As. 

5. In the Save As dialog box, give the file a new name in the file name box. 

6. Select Word Template in the Save As type list 

7. Click Save. 

3.11 Formatting Your Text 

Formatting Fonts 

Changing Font with Font list on the Ribbon 

1. Highlight the text you want to apply the change of font to. 

2. Click the Home tab, in the Font group click the Font list arrow. 

3. Click the font you want. 
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To Change Font Size 

1. Click the arrow next to the font size. 

2. Click the size you want. 

-- OR --  

1. In the Font group click on Grow Font. 

2. To decrease the size, click on Shrink Font. 

 

To make the highlighted text bold, click on the bold button. To italicize, click on the Italic button. 

Adding color to Text 

1. Select the test you want to format. 

2. Click on the Home tab, in the Font group, click the highlight button arrow and click the color that 
you want. 

3. To remove the highlight, click No Highlight. 

3.12 Bullets and Numbering 

You can quickly add bullets or numbers to existing lines of text. 

To add Bullets or Numbering to a list: 

1. Select the text that you want to add the Bullets or Numbers to. 

2. Click on the Home tab, in the Paragraph group, click Bullets or Numbering. 

 
 

Bullets Panel 

3.13 Changing Spacing of Text 

Spacing of Paragraphs 

By default spacing is increased slightly before paragraphs. 

1. Select the paragraph before or after you want to change the spacing. 

Bullets 
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2. Click on the Page Layout tab, in the Paragraph group, click an arrow next to Spacing Before or 
Spacing After and enter the amount of space that you want. 

 

 

Indent & Spacing Panel 

Changing the Line Spacing 

To space all lines evenly within a paragraph, use exact spacing. 

1. Select the paragraph for which you want to change the line spacing 

2. Click on the Home tab, in the Paragraph group, click Line Spacing. 

 

Line Spacing 

3. Choose the number of line spaces you want. 

4. To choose more precise spacing measurements, Line Spacing Options, and then select the 
options that you want under Spacing. 

Line Spacing Options 

Single - This option accommodates the largest font (font: A graphic design applied to all numerals, 
symbols, and alphabetic characters, also called type or typeface. Arial and Courier New are examples of 
fonts. Fonts usually come in different sizes, such as 10 point, and various styles, such as bold in that line, 
plus a small amount of extra space. The amount of extra space varies depending on the font that is used.  

1.5 lines - This option is one-and-one-half times that of single line spacing.  

Double - This option is twice that of single line spacing.  

At least - This option sets the minimum line spacing that is needed to fit the largest font or graphic on 
the line.  

Exactly - This option sets fixed line spacing that Microsoft Office Word does not adjust.  

Multiple -This option sets line spacing that is increased or decreased from single spacing by a percentage 
that you specify. For example, setting line spacing to 1.2 will increase the space by 20 percent. 

Indentation 

Indentation determines the distance of the paragraph from either the left or the right margin. Within the 
margins, you can increase or decrease the indentation of a paragraph or group of paragraphs. 
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Indenting First Line of a Paragraph. 

1. Click in front of the line that you want to indent. 

2. Click on the Page Layout tab; click the Paragraph Dialog Box Launcher. 

3. Click on the Indents and Spacing tab.  

 

Paragraph Dialog Box Launcher 

4. In the Special list under Indentation, click First line. 

5. In the By box, set the amount of space that you want the first line to be indented. 

Creating a Hanging Indent 

1. Click somewhere within the paragraph. 

2. Click the upward-pointing arrow at the left side of the Ruler. This is the Hanging Indent pointer. 

3. Drag the pointer to the right.  The first-line point stays in place at the left margin, and the rest of 
the paragraph shifts. 

 

Hanging Indent Pointer 

3.14 Aligning Paragraphs 

This refers to the appearance and orientation of the edges of the paragraph. 

Align text to the Left or Right 

1. Select the text that you want to align. 

2. Click on the Home tab. 

3. In the Paragraph group, click Align Left , or Align Right . 

Center the Text 

1. Select the text that you want to center. 

2. Click on the Home tab. 

3. In the Paragraph group, click Center 

Justify the text 

This aligns text to the left and right margins, inserting extra spaces between words to even out the 
edges. 

1. Select the text you want to justify. 
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2. Click on the Home tab. 

3. In the Paragraph group, click Justify . 

3.15 Styles 

Applying a Style 

A Style is a collection of formatting settings. 

 Select the text to which you want to apply. 

 Click on the Home tab. 

 In the Styles group, click the style that you want.  

 If you don’t see the style that you want, click the More button  to expand the Quick Styles 
gallery. 

Note: You can see how selected text would look with a particular style by placing the mouse pointer over 
the style. 

 

Styles Gallery 

3.16 Borders and Shading 

Adding Borders and Shading 

1. Select the text. 

2. Click on the Page Layout tab. 

3. In the Page Background group, click on Page Borders. 

4. Click on the Borders tab. 

5. Under Settings, click on any of the settings, to modify the edges of the border. 

6. Choose a border style, color and width. 

7. Click on the Shading tab. 

8. Under Fill, click the arrow and choose and click on a color. 

9. Click Ok. 
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3.17 Line numbers 

Add line numbers to a document or page 

1. Click on the Page Layout tab. 

2. In the Page Setup group, click on Line Numbers. 

3. Click on any of the options. 

3.18 Page Layout 

Setting Page Orientation 

By default Word 2007 creates all new documents in the portrait (vertical) mode. 

1. Click on the Page Layout tab. 

2. In the Page Setup group, click on the Orientation button. 

3. Click Landscape or Portrait. 

Margins 

Page Margins are the blank spaces around the edges of the pages. 

Change or Set Page Margins 

1. Click on the Page Layout tab. 

2. In the Page Setup group, click Margins. 

3. Click the margin type that you want. For the most common margin width click Normal. 

4. To set your own margin settings, click Margins, Custom Margins, and then in the Top, Bottom, Left, 
and Right boxes, enter new values for the margins. 

Page Breaks 

Insert a page break in uyour document as follows: 

1. In your document, click where you want to start a new page. 

2. Click on the Insert tab. 

3. In the Pages group, click Page Break. 

 

Pages Group 

Headers and Footers 

Headers and Footers are the areas in the top, bottom and side margins of each document. You can insert 
or change text or graphics in the header and footer.  
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Inserting Headers and Footers 

1. Click on the Insert tab. 

2. In the Header & Footer group, click Header and Footer. 

2. Click the header or footer design you want.  

Inserting Text or Graphics in head footer 

1. Click on the Insert tab. 

2. In the Header & Footer group, click Header and Footer. 

2. Click Edit Header or Header Footer. 

3. Insert text graphics. 

3.19 Previewing a Document 

1. Click the Office Button  and point to print. 

2. Click on Print Preview. 

2. Click the One Page or Two Pages button. 

3. Click the Close button to return to document. 

 

3.20 Printing a Document 

1. Click the Office Button . 

2. Click Print. 

2. In the Print dialog box, click the Name list arrow and click the printer you want. 

3. Under Copies, click the up or down arrow to specify the number of copies to print. 

4. Click Ok. 

3.21 Inserting Objects and Graphics 

Pictures and Clip art can be can be inserted or copied into a document from many different sources. This 
includes copying from a Web page, or inserted from a file where you save pictures on your computer. 

Inserting Clip Art 

1. Click on the Insert tab. 

2. In the Illustrations group, click Clip Art. 

2. In the Clip Art task pane, in the Search for text box, type a word or phrase that describes the clip 
art that you want. 
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3. Click Go. 

4. In the list of results, click the art to insert. 

  

Clip Art 

 

Inserting a Picture from a File 

1. Click where you want to insert the picture in your document. 

2. Click on the Insert tab. 

3. In the Illustrations group, click Picture. 

4. Locate the picture that you want to insert. 

5. Double-click the picture that you want to insert. 

3.22 Tables  

Creating Tables 

Using Table Templates 

You can use table templates to insert a table that is based on a gallery of preformatted tables. Table 
templates contain sample data to help you know what the table would look like when you add your data. 

1. Click where you want to insert the table. 

2. Click on the Insert tab 

3. In the Table group, click Table, point to Quick Tables, and then click the template that you want. 

Using the Insert Command 

You can use the Insert Table command to choose the table dimensions and format before you insert the 
table into the document. 

1. Click where you want to insert the table. 

2. Click on the Insert tab. 

3. In the Tables group, click Table, and click Insert Table. 

4. Under Table size, enter the number of columns and rows. 

5. Under Autofit behavior, choose options to adjust table size. 
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3.23 Keyboard Shortcuts in Microsoft Word 2007 

These are ways of doing common tasks using certain keys on the keyboard. 

Eg. CTRL+B means pressing the CTRL key and the B key at the same time on the keyboard 

Common Tasks in Microsoft Word 

CTRL+B Makes letters Bold 

CTRL+I Makes letters Italic 

CTRL+U Underlines letters 

CTRL+C Copy the selected text or object 

CTRL+X Cut the selected text or object 

CTRL+V Paste text or an object 

CTRL+O Open a document 

CTRL+W Close a document 

CTRL+S Save a document 

CTRL+F Find a text in a document 

ALT+CTRL+P Switch to Print Layout view 

CTRL+P Print a document 

ALT+CTRL+I Switch in and out of Print Preview 

CTRL+ENTER Insert a Page Break 

CTRL+ Shift +F Opens the Font dialog box to change the font 

CTRL+ Shift +> Increase the font size 

CTRL+ Shift +< Decrease the font size 

CTRL+1 Single Line spacing 

CTRL+2 Double Line spacing 

CTRL+5 Set 1.5-line spacing 

CTRL+M Indent a paragraph from the left 

CTRL+T Create a hanging indent 

ALT+CTRL+Shift+S Opens Styles Task Pane 

F7 Checking Spelling and Grammar 

 

3.24 Document Collaboration 

If you use Microsoft Word in a business environment then something called Document Collaboration can 
come in handy. This is where more than one user makes changes to a document. All the changes can 
then be reviewed and compared to the original before a final approved copy goes out. In this section, 
you'll see how it all works. 

So open up the file called Cut Copy Paste. Hopefully you haven't saved your changes over the top of it. If 
you have, you can download it here by right-clicking below. From the menu that appears, select either 
Save Target as, or Save Link As. 

3.25 Get All the Extra Files 

Save this document with the name LetterChanges.docx. Your letter should look like this when you open 
it up in Word: 
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To make changes that others can see, click on the Review tab in the Word ribbon. Locate the Tracking 
panel, and the Track Changes item: 

 

Click on Track Changes to see the following menu: 

 

Click the Track Changes item from the menu. Nothing will happen until you make your first change. 

Delete one of the "Dear's" from the first line of the letter. You'll then see a new panel appear on the 
right. You'll also have an underline stretching right across the first line of the letter: 
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In the new panel on the right (called the Markup Area), you can see that a red rounded rectangle is 
surrounding the words "Deleted: Dear". This is telling what change you made. 

If you can't see a Markup Area then click on Show Markup from the Tracking panel. From the Show 
Markup menu, select Balloons then Show Revisions in Balloons: 

 

Move the words "Johny Browny" down to the line after "Yours truly". Then move "Eric Mensah" up to 
replace "Johny Browny". You should see more comments and underlines appear: 



EDUNet Computer Manual 

 
 

March 2012 45 | P a g e  

 

Now study the document and makes changes where you feel they are needed. You should then end up 
with a document like this one: 

 

3.26 Adding Comments to a Document 

You can add comments to the document, as well. We'll add a comment that we have inserted the word 
"not" into the text. 

So highlight the word "not" after "I repeat" (or insert the word, if you haven't already). Now locate the 
Comments panel, and the New Comment item: 

 

Click on New Comment. You'll see a new panel appear in the margins. Type something for your 
comment, something like "Inserted the word 'not'": 
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If you need to, add more comments. You can add as many as you like. 

To delete a comment, click inside the comment in the Markup Area on the right. From the Comments 
panel, click the Delete option. You can also jump from comment to comment by clicking the Previous 
and Next items. 
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4 Web Browsing with Internet Explorer 

4.1 Overview 

The Internet, also known as "the Net," is a worldwide system of computer networks in which users at any one 
computer can get data from any other computer. The Internet is self-sustaining and is used by hundreds of 
millions of people worldwide. For most Internet users, email and instant messaging has replaced the Post Office 
for short messages. You can also carry on live conversations with other computer users using Internet Chat. 
Currently, Internet telephone hardware and software allow real-time voice conversations (VOIP) including free 
long distance for voice calls between two computers.  

The most widely used part of the Internet is the World Wide Web. With the web, you have access to millions of 
pages of information. Web browsing is done with a web browser. Here are the instructions for browsing using 
Microsoft Internet Explorer: 

4.2 Opening Internet Explorer (IE) 

Internet Explorer (I.E.) is by far the most widely used web browser on the planet. Every computer, even most 
Apple iMacs, have it installed and most pages are optimized for I.E.  These beginning sections will help you learn 
and understand the basic operations and functions of Internet Explorer.  

1. Click the Start button in the bottom left hand corner of your screen. 

 

  

2. Click on All Programs.  

3. Click on  Internet Explorer. 

4.3 Web Browsing or ‘Surfing the Net’ 

Browsing Using A URL 

A URL is a formatted text string used by Web browsers, email clients and other software to identify a network 
resource on the Internet. Network resources are files that can be plain Web pages, other text documents, 
graphics, or programs. URL strings consist of three parts (substrings): 1. network protocol (e.g., HTTP, FTP, etc) 
2. host name or address 3. file or resource location 

These substrings are separated by special characters as follows: protocol: // host / location  

For example, the GES SharePoint web site URL is http://10.20.251/. 

The important thing to remember when you first begin browsing the web is the URL of a site you wish to visit. 
Go up to the Address Bar near the top of the page, and click on it. Now you can type in the URL of the site you 
want, and then press enter. Internet Explorer will go to this site directly from whatever document you were 
currently viewing. (Address Bar shown below) 
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Browsing By Clicking on Links 

On most web sites, certain words or phrases appear in text of a different color than the rest and sometimes 
also underlined. When you point to one of these words or phrases by clicking the left button of your mouse, 
you will be transferred to the page that is associated with this word or phrase. These are called hyperlinks or 
links. Sometimes there are buttons, images, or portions of images that can be "clicked". If you move the pointer 

over a spot on a web site and the pointer changes into a hand, this indicates that you can click it and be 
transferred to another site. 

4.4 Internet Explorer Toolbar 

The fastest way to get to a place that you don’t know its address and you want to search for, is to click on the 
Search button on the Internet Explorer toolbar. 

The main toolbar is composed of numerous buttons. Each of these buttons has a different function and purpose 
in Internet Explorer. The individual buttons will each be discussed in the following sections.  
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 The Back Button: This button will take you back to whatever document you were previously viewing. 
Pressing it immediately takes you back one document. If you have browsed many pages, or are well into 
a multi-page document, pressing it repeatedly will continue to back you up one page at a time. Once 
you reach your starting location, it will be grayed-out and unavailable.  

 The Forward Button: This button will take you forward to the next document if you have previously 
browsed multiple documents and had then backed-up to the page you are currently viewing. (If you 
have not backed up at all, the forward button will be grayed-out) Pressing it repeatedly will continue to 
move you forward one page at a time. You can move forward until you reach the last page that you had 
browsed.  

 The Stop Button: The stop button stops ANY current operations by Internet Explorer. It will stop any 
type of file from loading. It can also be used to stop animations from continuing once a page is loaded. 
If you press it before a page has finished loading, the page will display everything it had finished loading 
before the stop button was pressed. If a document is completely loaded and there are no animations, 
movies, or other files still running, the stop button will have no immediate function.  

 The Refresh Button: This button will reload the current document that you are viewing. It is useful if 
the page updates very frequently so that you can view these changes as soon as they are available. If 
you are loading a document and the transfer was interrupted, you can reload the full document again 
by clicking here.  

 The Home Button: This button will return you to the page you have selected as the default start-up 
page for Internet Explorer. It will not take you back to the beginning of your web browsing; it will just 
return you to your home location from where you are. If you press back after reaching your home page, 
you will go back to the page you left after you hit the Home button.  

 The Search Button: This button will take you to the page you have selected as the default Web search 
page for Internet Explorer. If you have not selected a page it will take you to Microsoft's default search 
page.  

 The Favorites Button: This button will open up the Favorites menu. You can choose a favorite that you 
wish to go to from the list, add a favorite to the list, or organize your favorites from this menu.  

 The Print Button: The print button will bring up a Print dialog box. In the box you can decide if you 
would like to print the contents of the page you are viewing, how many pages you will print, and also 
how many copies you will print. Keep in mind that if you try to print a page that is graphics intensive, 
you will need a printer that is capable of printing graphics. Also, the more graphics and pages a Web 
site has, the longer it will take to print.  

 The Font Button: Pressing this button causes Internet Explorer to cycle through the available font sizes. 
This button is useful if the text is too small to read, or too large to fit comfortably in the window.  

  The Mail Button: This button will open into a drop down menu from which you can select to read or 
send E-Mail. You can also open up your newsgroups from this menu.  

 The Edit Button: This button will ONLY be on your toolbar if you have a Windows system Web editor 
(such as Microsoft FrontPage or Microsoft Word) installed on your computer. If you press this button, it 
will launch that editor and open the document you are currently viewing in it. 
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4.5 Google Search Engine 

A Search Engine is a service for locating documents on the Web that contain a subject or phrase that you enter 
into the search parameters. You can also browse through the categories of Web sites that the search engines 
have already organized for you.  

Google is a crawler-based engine, meaning that it has software designed to "crawl" the information on the 
Internet and add it to its database. Google has the best reputation for relevant and thorough search results. 
Google's home page is clean and simple. There is more than one option on Google's home page. You can search 
for web sites, images, comments in discussion groups, news, shopping sites and more. In fact, Google is so 
popular that it has become a verb meaning look it up on the Web: “go google it!” 

 

Google Ghana Home Page 

Using Google Search 

 Just enter a word, multiple words or a phrase and hit “enter”. Google will come up with results that 
contain all the words in the search bar. Google doesn't care about capitalized words and will even 
suggest correct spellings of words or phrases. Google excludes common words such as “where” and 
“how”, and since Google returns results that include all of the words you enter, there's no need to 
include the word "and”. 

 Try to be as specific as possible. If you are searching for a specific quote, Google will search for the 
entire phrase just how it appears in between the quotes. 

 Use common words, such as "and", "not" and numbers ONLY if you want them included in the search. 
Google excludes them otherwise. If you want them included, use a phrase search by putting quotations 
around your search query, or include the common word by putting a space and a plus sign right in front 
of it.  

 Exclude unwanted results. If you want to narrow down your searches, place a "-" (minus sign) in front of 
words you want to avoid. 
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4.6 Downloading Files 

Downloading is a term that means transferring files or data from one computer to another. To download means 
to receive; to upload means to transmit. 

If you want to download a file to keep on your computer, you just have to click on the file link on the web site 
with your mouse. A window will pop up asking you to either run the file or save it to your computer. If you click 
on the run button you will not be able to save the file. You will only be able to view the file. 

 

If you click on the save button the following window will pop up asking where on your hard drive you would like 
to save the file. 

 

You can click on the ‘Save in’ drop down arrow to find the right folder on your hard drive for the file. Once you 
have clicked on your destination folder you just have to click on the save button. 
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4.7 Online Safety 

Viruses 

A computer virus is a program that invades your computer system, hides there, and makes copies of (replicates) 
itself. Viruses spread when you launch an infected application or start up your computer from a disk that has 
infected system files. 

Viruses behave in different ways. Some viruses stay active in memory until you turn off your computer. Other 
viruses stay active only as long as the infected applications are running. Turning off your computer or exiting the 
application removes the virus from memory, but does not remove the virus from the infected file or disk. 

Some viruses are programmed specifically to damage the data on your computer by corrupting programs, 
deleting files, or erasing your entire hard disk. 

All computer viruses are manmade. A simple virus that can make a copy of it self over and over again is 
relatively easy to produce. Even such a simple virus is dangerous because it will quickly use all available memory 
and bring the system to a halt. 

Spyware 

Spyware is a general term used for software that performs certain behaviors such as advertising, collecting 
personal information, or changing the configuration of your computer, generally without appropriately 
obtaining your consent. 

You might have spyware or other unwanted software on your computer if: 

 You see pop-up advertisements even when you’re not on the Web. 

 The page your web browser first opens to (your home page) or your browser search settings have 
changed without your knowledge. 

 You notice a new toolbar in your browser that you didn’t want, and find it difficult to get rid of. 
Your computer takes longer than usual to complete certain tasks. 

 You experience a sudden rise in computer crashes. 

EDUnet computers have antivirus software installed and activated. Users must not disable Virus and Spyware 
Protection installed on your computer. 

4.8 Printing Web Documents 

If your computer is connected to a printer, you can print out any Web document that you wish whether you are 
viewing it on the Web, or if you are just viewing it from your hard disk.  

Just click on the dropdown arrow besides the toolbar button that looks like a printer. 

  

From this menu select Print; the Print dialog box will appear. (An easier way to open this box is to simply click 
the Print button on the main toolbar or to press CTRL-P)  

In this dialog box you can decide how you would like to print the contents of the page you are viewing, how 
many pages you will print, and how many copies you will print. Keep in mind that if you try to print a page that 
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is graphics intensive, you will need a printer that is capable of printing graphics. Also, the more graphics and 
pages a Web document has, the longer it will take to print. Be especially mindful that when you print, you are 
not just printing what you see but the entire contents of the Web page. This may be a great many screenfuls 
and could be scores of pages in length. Think before you print. 

 

The last step is to simply click on the print button. 

Setting Your Default Start-Up Page 

The Start-Up page is the Web Site or document that Internet Explorer will open automatically every time that 
you start the program. These steps will show you how you can change this page to whatever location you 
prefer.  

 From the Tools button dialog box, click on the Internet Options folder tab at the bottom of the dialog 
box. You can change the start-up page from here. (The customize section is outlined in red for your 
convenience).  

 Click on General and then click in the Address box.  

 Type the address of the page you would like Internet Explorer to open each time you start the program. 
If you are satisfied with your choice and are done setting options, click on the Apply button then OK at 
the bottom of the Internet Options box.  
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5 Using GES Email (Zimbra) 

5.1 Getting Started 

When your EDUNet access was approved you were given a GES Zimbra Email account which should be used for 
all GES email correspondence.  

You must login to Zimbra using the correct username for your email account, usually your first name then a dot 
(period) followed by your last name, for example kojo.ashante. Note that your email address is 
username@ges.gov.gh, for example kojo.ashante@ges.gov.gh. 

This document explains how to use Zimbra Email for the most common tasks: 

 sending and receiving email messages, 

 replying to or forwarding email, 

 adding a contact to your contacts list, 

 attaching a document to an email, 

 sorting your messages, 

 organizing your email messages using custom folders 

There are many other functions available in Zimbra for you to explore once you have mastered these basics. 

5.2 Zimbra Desktop 

You can access Zimbra Email on the Web1 or by running the Zimbra Desktop application on your computer. The 
advantage of Zimbra Desktop is that you may compose and save email even when the network is unavailable, 
so we will be describing Zimbra Desktop in this tutorial. If you have not already done so, you may download 
Zimbra Desktop for free from the following location: 

 http://www.zimbra.com/downloads/ 

Simply follow the installation instructions on the download Web page. 

5.3 Starting Zimbra Desktop 

To start Zimbra Desktop Email, look for the Zimbra Icon on your desktop and double-click it. 

 

 

In a few moments the Zimbra desktop will appear as below: 

                                                 
1 GES Zimbra is available on the Web at http://webmail.ges.gov.gh. 

mailto:username@ges.gov.gh
mailto:kojo.ashante@ges.gov.gh
http://www.zimbra.com/downloads/
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There are many functions packed into the desktop. Let's work through them from top to bottom.  

5.4 Working with Zimbra Desktop Email 

Title Bar 

At the very top of the Zimbra Desktop window is the title bar. 

 

On the right side of the title bar (outlined in red in the figure) is a field for “people search.” Use that to look for 
other users. For example, if you type “Dav” in the field you will see all the users whose names begin with those 
letters. You will find this handy when you want to compose an email to someone on the EDUnet network. 

Next to the search field is a status message indicating that Zimbra desktop is “online.” This means that the 
network is up and the Zimbra server at headquarters is alive and well. When Zimbra is in online your email will 
arrive and be sent without delay. When the network or server is down the status will show “offline.” Email will 
not be received or delivered until Zimbra is online again. 

Next are two controls: one for launching Zimbra Help and the other for changing its Setup. 
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Tool Bar 

Below the title bar is a row of tabs called the Tool Bar. Selecting a tab will change the windows below it to 
reflect the chosen function. In the image below, themail tab is selected (notice it is lighter than the other tabs). 
There are also tabs for Address Book, Calendar, Tasks, Briefcase, Preferences and Social.  

 

Address Book is for managing your email contact information. Calendar is for managing appointments and 
reminders. Tasks is for managing a list of things to do. Briefcase allows you to upload and manage documents 
on the Zimbra server. Preferences allows you to customize the way Zimbra desktop looks and behaves. Users 
are requested not to use the Social functions of Zimbra Email. 

For the remainder of this tutorial we will describe working with Zimbra to send, receive and organize your email 
correspondence. The remaining features are left as an exercise for the reader using Zimbra's documentation 
and help system. 

5.5 Zimbra Mail 

When the mail Tab is selected there are two tool bars and three key panes that you need to understand.  

Organizing Your Messages 

From left to right, the folder pane, the message list pane and the message pane are used to organize and 
navigate through your sent and received email messages.  
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The folder pane is highlighted in the figure below. 

 
 

Initially it contains the following folders: 

 Inbox folder, where your received messages arrive, 

 the Sent items folder where outgoing messages are stored, 

 the Draft items folder where messages that have been started but not sent are stored,  

 the Junk items folder where junk email is automatically moved based on your junk mail preferences 

 the Outbox, where messages are staged before being sent; note that messages may sit here when 
Zimbra is offline until it recovers and is able to send 

 the Trash folder where deleted messages are moved before being permanently removed, for example 
when Zimbra exits 

When you select a folder by left clicking on it in the folder pane the messages contained in the folder are 
summarized in the message list pane to its immediate right. Below Inbox is selected so these are messages that 
I have received. 
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When you select a message in the message list pane, the message summary is highlighted in blue and the 
contents of the selected message are shown in the message pane to its right. The message content pane shows 
who sent the message, its recipients and the body of the message itself as shown below.  

In the example above a simple test message in my Inbox is selected. The message is to me (Rick Morrison) from 
a colleague, John Spracklin. The message body is just the single word “test.” Obviously you will have much more 
interesting messages than this. To review messages that you have Sent select the Sent folder. 

Email Conversations 

Note that messages may be grouped into conversations. A conversation is an original message that you sent or 
received plus other messages sent or received in reply to the original. A conversation is indicated in the 
message summary list by a dark triangle icon. You can view all messages in a conversation by clicking on the 
triangle icon to open and close the group. 
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Composing and Sending a Message 

 
To compose a message click the New button in the toolbar above the message content pane. 
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A new message window will open. 

 
In the To field you enter the email address of you recipient(s). If they are in the GES corporate directory of email 
accounts you should get some suggestions as soon as you start typing. You can click on a suggestion to select it 
and it will be entered into the To field for you. If the email is to a new contact then you will need to enter the 
correct email address manually. In the Subject field enter a meaningful topic to describe the purpose of your 
message. In the case of formal emails that are required by GES admin policies the precise subject line may be 
dictated. 

When you are done, click the Send button.  
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If you won't be sending your message right away, click the Save button. The message will be saved to the Draft 
folder. Later, when you are ready to continue you can select the Draft folder from the folder pane to find your 
unsent email. Select it and complete your message. Then click the Send button as before.  

If you simply want to abandon the email hit the Cancel button. 

Receiving Email 

There isn't much involved in receiving email. If your colleagues know your email address their messages will 
simply “show up” in your Inbox. Ordinarily, you  check your received email simply by clicking on the Inbox in the 
folder pane as discussed earlier. 

If you are not receiving email and you think you should be it's possible that Zimbra is offline (remember to 
check the status). You may also force a check for email by right-clicking on your name in the folder pane and 
then selecting Send/Receive in the pop up. When you select Send/Receive you should see a busy animation 
beside your name. 
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Replying to Email 

When you receive an email from a colleague it is very easy to reply. 

You already know how to select messages by using the folder pane and the message summary list. You reply to 
an email by selecting a message in the message summary list and clicking the Reply button. The compose 
window will be shown with the body of the selected message already present. Now you simply add your reply 
text and hit the Send button. The email address of the person who sent the message to you is already entered 
in the To field automatically. If you don't want to include their original message text in the reply you can delete 
it in the compose window. 

Forwarding Email 

Another way to send an email is by forwarding an existing message. You can forward an email by selecting a 
message in the message summary list and clicking the Forward button. The compose window will be shown 
with the body of the selected message already present. Now you simply need to add any introductory text of 
your own (or not) and the email address of the person you want to forward the message to. 

 

 

 

 



EDUNet Computer Manual 

 
 

March 2012 64 | P a g e  

By the way, please do NOT forward spam like I'm doing in the example! Much better is to delete the spam. 
Deleting is the last key function you need to know about managing your messages. Simply select the message 

or messages you want to delete and click the Delete button. You may also hit the delete key on your keyboard. 

 

Adding Attachments 

We've covered how to send simple text emails but what if you want to send someone a Word document or a 
PDF file? These are called email attachments. Before you send your email you can add one or more attachments 
by clicking on the Add Attachment button. 

A pop up dialog will appear allowing you to browse your local disk to select the file(s) you want to attach. When 
you are done hit the attach button in the dialog.  

Note that you may also drag-and-drop files from your local disk using Windows explorer to locate the files. 

 

 



EDUNet Computer Manual 

 
 

March 2012 65 | P a g e  

Your unsent email will show the attachments and their sizes just below the Subject of your message. And, don't 
forget – you still need to hit the send button on your message! 
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Just bear in mind that sending one or several large files as attachments may take a long time to send over the 
network. In some cases your email may even fail if there is limited space on the server. Be cautious! 

A more efficient approach than email, especially when sharing files with several users, is to use the GES 
SharePoint server to upload your documents. Then you can simply notify your recipients of the link they should 
use to access the document in a short email. See the SharePoint user manual for details. 
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Creating Custom Folders 

You may wish to create custom folders of your own naming to keep your messages organized. You can create 
your own folder by Right-Clicking on the parent folder and selecting New Folder from the pop-up menu.  

A new folder dialog pane will pop up where you can name your custom folder, select a custom color and 
indicate where the new folder should be located. Click Ok when you are done and a new empty folder with the 
name you chose will appear in the folder pane. 

 

In the figure below, I have created a custom folder called GEDP where I keep all of the correspondence relating 
to the GEDP project that I'm working on.  

You may now move email messages (or entire conversations) to your custom folders from the other folders, for 
example, Inbox or Sent folders. To move a message right-click the message in the message summary list and 
select the target folder from the Move dialog. 



EDUNet Computer Manual 

 
 

March 2012 68 | P a g e  

Note that the use of custom folders to organize your messages is completely optional and many users only use 
their Inbox and Sent email folders along with the Zimbra message search and filter options. It's up to you! 
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5.6 Searching for Email Messages 

Over time you will collect hundreds, even thousands of email messages. How do you find that important email 
from 6 months ago? That's what the Search button is for. Enter text in the search field that might be contained 
in the in the message.  

Optionally you may restrict the folder to be searched by typing “in:”. You will be prompted to select a folder to 
be searched. Follow this with your specific search text. In the example below, I'm searching for the word “wiki” 
in the GEDP subfolder of my Inbox. 

When ready, click the Search button. Your results, if any, will appear in the message summary pane.  
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5.7 Handling Spam 

 

Despite the best efforts of GES IT Admin staff you will undoubtedly receive junk email from time to time. You 
may mark the sender as a source of Spam (unwanted email) by selecting the message from the message list 

pane and then clicking the Spam button.  

The message will be moved to the Junk mail folder and all future correspondence will be marked as junk 
automatically. To undo a Spam setting. Find the message in the Junk folder and click the Not Spam button. 

5.8 Managing Your Contacts 

The second most important tab in the toolbar after themail tab is the Address Book tab. Address Book is where 
you manage the names and email addresses of the people you correspond with. You may even record 
telephone numbers and physical addresses for your contacts if you wish. Once someone has been added to 
your contacts list they will also appear in the pick lists for people when you are composing messages. 

Select the Address Book tab for the first time and your Zimbra Desktop will display an empty list of contacts like 
the following: 

You can view all addresses by selecting the “All” tab or by the first latter of the last name by selecting the 
associated button. 
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And, just as we did for email addresses, we can use the Search button to find contacts in the Address Book. 

To illustrate, let's now add an address for my fictional friend Frodo Baggins. We select the New button to bring 
up the New Address pane and enter the details we care about. 
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When you are finished entering address information click the Save button. You will return to the Address Book 
pane with your new contact being shown. 

Contacts are listed in a summary pane just like email messages. To view the details of a contact select the 
summary line in the summary pane and details will be show to the right.  

To delete a contact select it in the summary page and click the Delete button. 
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